
Welcome to Adobe Photoshop™ version 3.0 software for the Windows™ 3.x and 
Windows NT environments. Please refer to the Adobe Photoshop Getting Started Guide 
for installation instructions. This Read Me file contains last-minute product information 
and updates to the Adobe Photoshop user documentation, including:

· Cancelling Operations
· The Win32s Subsystem and Adobe Photoshop
· The Win32s Subsystem and the Adobe Photoshop Installer
· The Win32s Subsystem and COMMDLG.DLL
· The Microsoft® Mouse Driver 9.0 and Adobe Photoshop
· The Logitech™ Mouse Driver and Adobe Photoshop
· New Scratch Disk / RAM Memory Relationship
· Working with Windows NT
· Converting Selections to Layers
· The Dither Option in the Gradient Tool
· Shortcuts for the Eraser Tool
· The Lighting Effects Color Picker
· Using Textures with Lighting Effects
· Filter Factory
· CompuServe GIF Format
· PostScript™ Language Image Data Encoding
· Transparency Mask
· The Apply Image Command
· About Floating Selections
· Changing Opacity on Single Layer Files
· Adding a Background Layer
· About Scanners
· Tips for Accessing Individual Calculation Modes
· Contact Information for Dainippon Ink and Chemicals, Inc. (DIC)
· Tips for the File...New Command
· Large Feather Radius and the “Pixels Not Found” message
· Moving Settings Files (Displacement Maps) to the Macintosh
· Support of Pressure Sensitive Tablets
· Screen Redraw when using Scroll Bars or the Hand Tool
· Screen Refresh in 256 Color Mode
· Saving TIFF files without Alpha Channels
· Windows Vector Fonts and the Type Dialog
· Large Type Sizes and the Type Dialog
· Drag and Drop Targeting within Adobe Photoshop
· About the Take Snapshot command
· Large Images and the Distort Filters
· Pen Tool Shortcuts
· Applying Filters to Layers with Layer Masks
· Saving TIFF files without extra channels
· Disabling Palette Previews to Improve Performance
· Incorrect Rasterization of TrueType Fonts



· Hard Disk Maintenance

IMPORTANT
Please complete your registration card and mail it today.  You must register to receive 
technical support and important product update information.

CANCELLING OPERATIONS
When attempting to cancel an operation in progress (when a progress bar is showing in 
Adobe Photoshop's status bar), it is best to hold down the Esc key (as opposed to tapping 
it) until the operation in progress has stopped.

THE WIN32S SUBSYSTEM AND ADOBE PHOTOSHOP
Under Windows 3.x, Adobe Photoshop 3.0 requires the existence on your system of the 
Microsoft Win32s subsystem.  This system allows 32-bit applications to run unmodified 
under 16-bit Windows 3.x.  The Adobe Photoshop Installer (SETUP.EXE) will install 
Win32s automatically whenever the Adobe Photoshop item is checked in the main 
installer dialog.

If you attempt to launch Adobe Photoshop 3.0 and instead of launching the program your 
screen momentarily goes black, then returns to the program you attempted to launch 
Adobe Photoshop from, or if you receive a Win32s error about a file being missing, 
please reinstall Adobe Photoshop 3.0 to re-install Win32s correctly.  If difficulties persist,
please contact Adobe Technical Support.

THE WIN32S SUBSYSTEM AND THE ADOBE PHOTOSHOP INSTALLER
There is a known incompatibility with the installation of Microsoft's Win32s subsystem 
and the LaserMaster® printer driver.  If you have a LaserMaster printer driver installed, 
the installation of Adobe Photoshop 3.0 will hang when trying to copy the file 
WINSPOOL.DRV.  The solution to this problem is to temporarily remove the 
LaserMaster printer driver from your system (including the device drivers that are loaded 
in the [386Enh] section of the SYSTEM.INI file), restart Windows, and rerun the Adobe 
Photoshop Installer.  Once the installation process is complete, you can re-enable the 
LaserMaster printer driver.

THE WIN32S SUBSYSTEM AND COMMDLG.DLL
The Adobe Photoshop Installer installs the latest version of COMMDLG.DLL to your 
WINDOWS\SYSTEM directory.  This version is required for full support of Win32s.  
Other applications may install older versions of COMMDLG.DLL.  If this happens, 
certain functions of Adobe Photoshop may no longer be available (for example, the Open 
dialog will not show the on-disk size of the selected file).  If this happens, simply reinstall
Adobe Photoshop 3.0 over itself - this will reinstall the proper version of 
COMMDLG.DLL.  You can also manually copy COMMDLG.DLL from Adobe 
Photoshop's Disk 1 into your \WINDOWS\SYSTEM directory (it is not compressed on 
Disk 1) to restore the current version.



THE MICROSOFT MOUSE DRIVER VERSION 9.0 AND ADOBE PHOTOSHOP
The Microsoft Mouse driver versions 9.0, 9.01, and 9.01a all cause a General Protection 
Fault in POINTER.DLL when Adobe Photoshop 3.0 is launched.  Generally, it is possible
to click the Ignore button to dismiss the dialog and continue working in Adobe 
Photoshop, but in some circumstances, the mouse may not be movable afterwards.  Both 
of these problems are solved by upgrading the mouse driver to version 9.01b.  If you have
difficulty with the Microsoft Mouse Driver, please contact Microsoft for an upgrade of 
your mouse driver software at 1-800-426-9400, or on CompuServe at GO MSIC.  In the 
interim, it is possible to use the Windows mouse driver that comes with your version of 
Windows - simply run the Windows Setup program and select the mouse driver called 
“Microsoft, or IBM® PS/2®” from the list.

THE LOGITECH MOUSE DRIVER AND ADOBE PHOTOSHOP
The current version of the Logitech mouse driver allows programming of the middle and 
right mouse buttons to accelerate operations in Windows applications.  If you attempt to 
assign one of these keys to the Undo function, please note that the Logitech driver maps 
the Undo function to the Alt-Backspace keystroke.  In Adobe Photoshop, the Alt-
Backspace keystroke does not undo the last operation, it performs a clear operation.  The 
shortcut for Undo in Adobe Photoshop is Ctrl-Z.

NEW SCRATCH DISK / RAM MEMORY RELATIONSHIP
With Adobe Photoshop 3.0, make sure that you have at least as much free disk space 
(after allocating the largest possible permanent swapfile allowed by Windows) as you 
have RAM allocated to Adobe Photoshop.  If you have more RAM than scratch disk 
space for a file -- for example, 100Mb RAM and 20Mb free disk space for a 10Mb file -- 
you may get a Scratch Disk Full error message when you attempt an operation, even 
though you have more than enough RAM for the operation.

WORKING WITH WINDOWS NT
If you are working with Windows NT, you should be aware that it does not support 
Adobe Acrobat or ATM™.  You may still rasterize TrueType™ fonts with Adobe 
Photoshop, however.

CONVERTING SELECTIONS TO LAYERS
To turn a selection into a new layer: Make a selection.  Float the selection (Ctrl-J).  Drag 
the new item in the Layers palette called “Floating Selection” in the Layers palette to the 
New Layer icon at the bottom of the Layers palette.  Alternatively, once the “Floating 
Selection” is selected in the Layers palette, select the Make Layer command from the 
Layers palette menu.

THE DITHER OPTION IN THE GRADIENT TOOL
When the Dither option is selected in the Gradient Tool Options palette, the foreground 
and background colors will be smoothed out by dithering the colors.  This will result in 
smoother blends with less banding.  If you posterize the resulting gradient you will get 
ragged edges.



SHORTCUTS FOR THE ERASER TOOL
Double-click the eraser tool to display the Eraser Options palette.  Holding down the Alt 
key and clicking on the Eraser tool cycles through the Eraser tool types (alternatively, 
you can press the “E” key on the keyboard to change the eraser type).  Holding down the 
Alt key while the Eraser tool is selected puts the Eraser tool in Erase to Saved mode 
(alternatively, you can check the “Erase to Saved” box in the Eraser Tool Options 
palette).  To erase an entire image, use the Erase Image button in the Eraser Options 
palette.

THE LIGHTING EFFECTS COLOR PICKER
The Lighting Effects filter uses the color picker selected in General Preferences.

USING TEXTURES WITH LIGHTING EFFECTS
Many grayscale textures, intended for use with the Lighting Effects filter, are included on
the Adobe Photoshop 3.0 Deluxe CD-ROM.  These textures should be loaded into an 
alpha channel using the Texture Fill filter under the Filter...Render menu.  See Chapter 10
of the Adobe Photoshop User Guide for more informaiton on loading and using these 
textures.

FILTER FACTORY
The Filter Factory, which allows you to create your own personalized filters for Adobe 
Photoshop, is included on the Adobe Photoshop 3.0 Deluxe CD-ROM.  Documentation 
for this filter, in the Adobe Portable Document (.PDF) format, is included in the same 
folder.  Use the Adobe Acrobat Reader software included on the CD-ROM to view or 
print the Filter Factory documentation.  Be sure to turn off the read-only attribute on the 
FFACTORY.8BF file after you copy it from the Deluxe CD-ROM, or it will not be 
possible to use the Make Filter feature of Filter Factory.

COMPUSERVE GIF FORMAT
Adobe Photoshop 3.0 will open and save CompuServe GIF files that are either 8-bit 
indexed color or grayscale.  It will not open 24-bit CompuServe GIF files.

POSTSCRIPT LANGUAGE IMAGE DATA ENCODING
There are three types of encoding available in the Print dialog when printing to PostScript
output devices and in the EPS Format dialog when saving images in EPS format.  ASCII 
encoding is the most generic, but creates the largest output files.  Binary encoding makes 
a smaller output file (speeding the transfer of the file to your output device) without 
modifying the original data.  JPEG encoding makes even smaller output
files, but the compression is “lossy”, meaning it may reduce the quality of your printed 
output.  When saving EPS files with JPEG encoding, you have four quality choices; low, 
medium, high, and maximum quality.  When printing with JPEG encoding, the high 
quality setting is always used.

Binary and JPEG encoding may not be supported over some network protocols, although 
AppleTalk® and EtherTalk have been extensively tested and found to work well.  Binary 
and JPEG encoding may not be supported with some 3rd party printer drivers (note that 



printer drivers provided by Apple or Adobe completely support these features). Some 
PostScript output devices only accept binary and JPEG encoded image data through their 
AppleTalk and Ethernet ports, and will not accept binary or JPEG encoded image data 
through their parallel or serial ports. Finally, JPEG encoding is only supported on 
PostScript Level 2 output devices (PostScript language errors may result if a file is 
printed with JPEG encoding to a Level 1 output device).

TRANSPARENCY MASK
Adobe Photoshop 3.0 provides a way to quickly load a selection consisting of all non-
transparent pixels on a given layer, called the “transparency mask”.  This will essentially 
accomplish the same thing as selecting the entire transparent area on a layer and inverting
the selection. Simply select the layer from which the selection is desired from the layers
palette, then press Control-Alt-T to load this special selection.

APPLY IMAGE COMMAND
Normally, the Apply Image command places the result of the application into the layer 
that was targeted (selected) when the dialog box was opened.  If the Alt key is held down 
while the Apply Image menu item is selected, an additional pulldown menu called Result 
will appear at the bottom of the dialog, allowing the result to be placed into a new 
document, a new layer, a new channel, or as a selection as well as into the current target 
layer.

ABOUT FLOATING SELECTIONS
Floating selections and non-background layers can have items extending off of the visible
canvas.  Normally, these items get clipped when a destructive pixel change happens to 
that layer (such as a paint stroke). However, it is possible after initially creating, 
dragging, or pasting items that extend off of the canvas to perform operations that will 
move the outlying pixels into the canvas area without having the outlying pixels
discarded. 

For example, when a selection is created with the type tool that extends outside the 
canvas area and appears as such in the Layers palette.  While a floating selection is 
active, it can be moved around with the Move tool or the selection arrow (which appears 
inside the selection when a selection tool is being used), and modified or repositioned 
with any of the Image...Flip, Image...Rotate, or Image...Effects commands without having
outlying pixels clipped out. It is possible to have valid image data on a non-background 
layer outside the canvas area when: - a floating selection is deselected (including type), - 
data is pasted from the clipboard, or - data is dragged in from another image.

In these cases, the data can still be moved around with the move tool or manipulated by 
Image...Rotate...Free or any of the Image...Effects menu items (except Perspective) 
without having the outlying pixels discarded.  In addition, the canvas size can be 
increased at this point to include the outlying pixels in the canvas area without having 
clipping occur. The above only applies when the pixels or selection is initially dragged, 
pasted, or moved into the area where part of it falls outside the canvas area.  Most other 
operations other than those listed above will cause pixels outside the canvas area to be 



immediately discarded.

CHANGING OPACITY ON SINGLE LAYER FILES
On images with only one layer with no background or on images with only one layer 
visible, changing the opacity down from 100% will not change the display of the image 
until a second layer or a background is added.

ADDING A BACKGROUND LAYER
To add a background to an image that does not have one, click the New Layer icon in the 
Layers palette or choose New Layer from the layer palette menu, then change its mode to
Background from the mode menu in the New Layer dialog (it's all the way at the bottom 
of the mode list and only shows up if there's no background in the current document).

ABOUT SCANNERS
Scanner drivers are provided by the manufacturers of the scanners. If you have problems 
with a scanner or during scanning, make sure that you have the latest version of the driver
from the manufacturer.  Note that Windows NT will require 32-bit TWAIN source 
modules, and will not work with the same scanner software as the same scanner did under
Windows 3.x.

TIPS FOR ACCESSING INDIVIDUAL CALCULATION MODES
Individual calculation modes can be placed on the Commands palette for backward 
compatibility with Adobe Photoshop 2.5 (in which these modes were individually 
selectable from the menu).  When in the New Commands dialog, select the Calculations 
item from the Image menu and notice it becomes a popout menu, allowing you to directly
select a calculation mode to assign to the Commands palette.

CONTACT INFORMATION FOR DAINIPPON INK AND CHEMICALS, INC. (DIC) 
Dainippon Ink and Chemicals, Inc.
3-7-20 Nihonbashi Chuo-ku
Tokyo 103 JAPAN
81-03-3272-4511

TIPS FOR THE FILE...NEW COMMAND
When creating a new file, Adobe Photoshop will size the new file in pixels based on the 
size of the current contents of the clipboard.  You can override this in two ways.  If the 
Alt key is pressed while the New command is chosen, the New dialog will ignore the 
clipboard size and open the New dialog with either the default or last entered parameters. 
Also, after the New dialog is open, you can select an open image from the Window menu 
to transfer the size of the selected image into the New dialog.

LARGE FEATHER RADIUS AND THE “PIXELS NOT FOUND” MESSAGE
It is possible when making a small selection with a large feather radius to create such a 
faint selection that no pixels are selected.  If you receive a “pixels not found” message, 
check the feather radius for the selection tool you are using, or increase the size of your 
selection if you wish to use a large feather radius.



MOVING SETTINGS FILES (DISPLACEMENT MAPS) TO THE MACINTOSH
In certain circumstances, some settings files from the PC may not show up in the 
appropriate file open dialog on the Macintosh®.  This is because not every dialog in the 
Macintosh version of Adobe Photoshop can check to see if a DOS file has an appropriate 
extension.  Specifically, displacement maps used with the Displace filter from the 
Windows version of Adobe Photoshop can't be recognized by the Macintosh version 
unless file type and creator resources are added manually once the file is on a Macintosh. 
All image files and most settings files do not exhibit this problem and will show up in the
appropriate open or load dialogs in Adobe Photoshop 3.0 for Macintosh.

SUPPORT OF PRESSURE SENSITIVE TABLETS
Under Windows 3.x, Adobe Photoshop 3.0 supports only pressure-sensitive digitizing 
tablets that are 100-percent compatible with the Microsoft PenWindows specification. 
Under Windows NT, Adobe Photoshop 3.0 supports only pressure-sensitive digitizing 
tablets that are 100-percent compatible with the WinTab32 specification.

For more information about compatibility, please contact the vendor of your tablet at: 

Wacom Technology Corporation: 800-922-6613
Kurta Corporation: 602-276-5533
CalComp: 800-458-5888

When using a pressure-sensitive device to vary size, color, or opacity, the highest 
pressure may not reach 100 percent. This is due to the driver software and is not caused 
by the Adobe Photoshop program. If you experience this problem, contact your tablet 
vendor for more information.

SCREEN REDRAW WHEN USING SCROLL BARS OR THE HAND TOOL
At times, you may experience slow performance or may be unable to interrupt a screen 
redraw while using the hand tool or moving around a larger image with the scroll bars. 
You may want to experiment with the program's alternate redraw technique if you 
experience this.  Simply press the Scroll Lock key to turn on the Scroll Lock light on 
your keyboard.  Now redraws after a scroll will only happen after the scrolling is 
complete, which improves performance.  Simply hit Scroll Lock again to disable this 
redraw mode change.  Also, when using the Full Drag option (in Windows NT) or with 
some older video drivers, you may find that image windows sometimes fail to redraw 
when resized.  If you experience this problem, you can either disable Full Drag by 
unchecking the option checkbox in the Desktop Control Panel, or you may want to add 
the following line to the PHOTOS30.INI file (found in your \WINDOWS or \WINNT35 
directory) to force Adobe Photoshop to redraw images more often:
NoOptimizeRedraw=1.

SCREEN REFRESH IN 256 COLOR MODE
When you use Adobe Photoshop while your video driver is set to 256 colors, background 
images will not be refreshed when changes to the foreground image take place to speed 



performance.  If you would like Adobe Photoshop to redraw every open image when a 
palette change takes place in 256 color mode, simply add the following line to your 
PHOTOS30.INI file (found in your \WINDOWS or \WINNT35 directory):
RedrawBkDocs=1

SAVING TIFF FILES WITHOUT ALPHA CHANNELS
If you wish to save an open image as a TIFF file which does not contain any of the alpha 
channels in the image, you must choose Save a Copy from the File menu to get prompted 
to exclude the alpha channels - Choosing Save or Save As will always include the alpha 
channels in your TIFF files.

WINDOWS VECTOR FONTS AND THE TYPE DIALOG
Because most Windows vector fonts are very thin and make very poor selections, these 
fonts are not displayed in the Type dialog Fonts menu.  If you specifically want these 
fonts (System, 8514oem, etc) to appear in the program's type dialog, you need to add the 
following line to your PHOTOS30.INI file (found in your \WINDOWS or \WINNT35 
directory):
ShowRasterFonts=1

LARGE TYPE SIZES AND THE TYPE DIALOG
In the Type dialog, if the Size checkbox is checked at the bottom of the dialog, the type 
preview box shows your type in the size it will be created in Adobe Photoshop.  At large 
sizes, the cursor may disappear in the preview box, and at extremely large sizes, the type 
will disappear altogether.  Adobe suggests unchecking the Size box when working with 
very large type sizes.

DRAG AND DROP TARGETING WITHIN ADOBE PHOTOSHOP
There are several ways to drag and drop information between different images in Adobe 
Photoshop, either to duplicate the image information or to perform operations on the 
image information (like make a selection or duplicate the image information).  For 
example, it is possible to drag selections and layers to other documents, either from the 
active image or from the layers palette. Please note that when a drag and drop operation 
is possible and the cursor is a “closed hand” (indicating that something may now be 
dropped), available targets for the operation will become highlighted (either by becoming
bolder or by having an outline drawn around them).  If no highlighing is taking place 
over a specific object or image, it is not a valid target for the current drag and drop 
operation.

ABOUT THE TAKE SNAPSHOT COMMAND
When using the Take Snapshot command, please note that the data in the snapshot will be
from the “merged data”, meaning what data is currently visible at the time the snapshot 
was taken.  If you wish to have a snapshot include only data from one layer, it must be 
the only visible layer at the time the snapshot is taken.

LARGE IMAGES AND THE DISTORT FILTERS
As in Adobe Photoshop 2.5, it is not possible to use the Distort filters on images or 



selections larger than 16Mb when running under Windows 3.x.

PEN TOOL SHORTCUTS
When the Pen tool is active, the documentation states that holding down the Alt key will 
toggle the Pen tool to the Convert Direction Point tool.  This is incorrect.  Holding down 
the Alt key while the pen tool is active will, when over the last created anchor point, 
allow you to change the outgoing direction point of that anchor.  Note that the status bar 
indicates the proper operation of the Pen tool when the Alt key is held down.

APPLYING FILTERS TO LAYERS WITH LAYER MASKS
Some filters will apply themselves to layer masks, even when the layer itself is targeted.  
If this happens, simply enter the Layer Mask Options dialog and select the Relative to 
Image option.  When the Layer Mask is set Relative to Image, all filters will apply to the 
layer data when the layer is targeted correctly.

SAVING TIFF FILES WITHOUT EXTRA CHANNELS
Photoshop 3.0 always includes extra (alpha) channels with TIFF files when saving 
normally.  If your target application requires the removal of these alpha channels to 
properly read the file, use Save a Copy from the File menu to create a new TIFF file.  You
will then be prompted whether or not to include the alpha channels in the new file.  
Alternatively, delete the alpha channels from the original image and resave normally.

DISABLING PALETTE PREVIEWS TO IMPROVE PERFORMANCE
For a slight performance increase, you may want to turn off the preview icons in the 
layers, channels, and paths palettes.  For each palette, select the Palette Options item from
the palette menu, then select the None radio button to disable the previews.

INCORRECT RASTERIZATION OF TRUETYPE FONTS
Some video drivers under Windows 3.x and the Win32s subsystem may cause TrueType 
fonts generated at certain point sizes to rasterize incorrectly or not at all.  The 
workaround for this problem is to create the text at a larger point size and scale it down to
the size you wish with the Image...Effects...Scale command.  Type 1 fonts rasterized with 
ATM do not have this problem.  You may also want to contact your video driver 
manufacturer to see if an updated driver addressing this problem is available. 

HARD DISK MAINTENANCE
It is a good idea to periodically perform a CHKDSK /F or SCANDISK operation to 
insure that no areas of your hard disk are unavailable to Windows.  This is especially 
important after experiencing any sort of difficulty within Windows.  To maintain optimal 
performance, you may also want to use a disk optimization tool, such as DEFRAG (that 
comes with MS-DOS 6.0 and later) or Norton's SPEEDISK, regularly.

Adobe Photoshop, ATM and PostScript are trademarks of Adobe Systems Incorporated or
its subsidiaries and may be registered in certain jurisdictions. Microsoft is a registered 
trademark and Windows and Windows NT are trademarks of Microsoft Corporation. 



Macintosh is a registered trademark and TrueType is a trademark of Apple Computer, Inc.
IBM and PS/2 are registered trademarks of International Business Machines Corporation.
CompuServe is a registered trademark of CompuServe, Inc.  LaserMaster is a registered 
trademark of LaserMaster Corporation.  All other brand and product names are 
trademarks or registered trademarks of their respective holders.
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